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Acronyms in This Document 
A list of acronyms used in this document. 

Acronym Definition 

EBR Embedded Block RAM 

DIF Decimation-in-Frequency 

DFT Discrete Fourier Transform 

DSP Digital Signal Processor 

FFT Fast Fourier Transform 

FPGA Field-Programmable Gate Array 

IFFT Inverse Fast Fourier Transform 

IP Intellectual Property 

LED Light-emitting Diode 

OPN Ordering Part Number 
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1. Introduction 
The Lattice Semiconductor’s Fast Fourier Transform (FFT) Compiler intellectual property (IP) core offers forward and 
inverse FFTs for point sizes from 64 to 16384. The FFT Compiler IP core can be configured to perform forward FFT, 
inverse FFT (IFFT) or port selectable forward/inverse FFT. The FFT Compiler IP core offers two choices of 
implementation: high performance (Streaming I/O) and low resource (Burst I/O). In the high-performance 
implementation, the FFT Compiler IP core can perform real-time computations with continuous data streaming in and 
out at clock rate. There can also be arbitrary gaps between data blocks allowing discontinuous data blocks. The low 
resource implementation can be used when it is required to use less slice (logic unit of Lattice FPGA devices) and 
Embedded Block RAM (EBR) and Digital Signal Processor (DSP) resources or if the device is too small to accommodate 
the high-performance version. 

To account for the data growth in fine register length implementations, the FFT Compiler IP core allows several 
different modes (fixed and dynamic) for scaling data after each radix-2 stage of the FFT computation. The low resource 
version also supports block floating point arithmetic that provides increased dynamic range for intermediate 
computations. The FFT Compiler IP core also allows the number of FFT points to be varied dynamically through a port. 

1.1. Quick Facts 
Table 1.1 to Table 1.7 provide quick facts about the FFT Compiler IP core for LattceECP2™, LatticeECP2M™, 
LatticeECP3™, LatticeXP2™, ECP5™ (LFE5U, LFE5UM) and ECP5-5G™ (LFE5UM5G) devices, respectively. 

Table 1.1. FFT Compiler IP Core for LatticeECP2 Devices Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported LatticeECP2 

Minimal Device Needed LFE2-6E LFE2-12E LFE2-6E LFE2-6E 

Resource 
Utilization 

Targeted Device LFE2-50E-7F672C 

Data Path Width 16 16 16 16 

LUTs 2193 2754 769 834 

sysMEM™ EBRs 3 6 3 3 

Registers 1686 2106 770 800 

MULT18X18ADDSUB 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond® 3.10.2.115 

Synthesis Synplify™ Pro M-2017.03L-SP1-1 

Simulation Aldec® Active-HDL™ 10.3 Lattice Edition 
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Table 1.2. FFT Compiler IP Core for LatticeECP2M Devices Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported LatticeECP2M 

Minimal Device Needed LFE2M20E 

Resource 
Utilization 

Targeted Device LFE2M35E-7F672C 

Data Path Width 16 16 16 16 

LUTs 2193 2754 852 920 

sysMEM EBRs 3 6 3 3 

Registers 1686 2106 805 835 

MULT18X18ADDSUB 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 

 

Table 1.3. FFT Compiler IP Core for LatticeECP3 Devices Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported LatticeECP3 

Minimal Device Needed LFE3-35EA 

Resource 
Utilization 

Targeted Device LFE3-95E-8FN672CES 

Data Path Width 16 16 16 16 

LUTs 2341 2907 820 893 

sysMEM EBRs 3 6 3 3 

Registers 1679 2098 803 833 

MULT18X18C  12 16 4 4 

ALU54A 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 

 

http://www.latticesemi.com/legal


 FFT Compiler IP Core 
 User Guide 

© 2006-2023 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-IPUG-02045-2.2  9 

Table 1.4. FFT Compiler IP Core for LatticeXP2 Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported LatticeXP2 

Minimal Device Needed LFXP2-5E LFXP2-8E LFXP2-5E LFXP2-5E 

Resource 
Utilization 

Targeted Device LFXP2-17E-7F484C 

Data Path Width 16 16 16 16 

LUTs 2185 2746 844 912 

sysMEM EBRs 3 6 3 3 

Registers 1684 2104 803 833 

MULT18X18ADDSUB 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 

 

Table 1.5. FFT Compiler IP Core for ECP5 (LFE5U) Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported ECP5 (LFE5U) 

Minimal Device Needed LFE5U-12F LFE5U-12F LFE5U-12F LFE5U-12F 

Resource 
Utilization 

Targeted Device LFE5U-85F-8BG756C 

Data Path Width 16 16 16 16 

LUTs 2335 2917 807 882 

sysMEM EBRs 3 6 3 3 

Registers 1679 2098 803 833 

MULT18X18D 12 16 4 4 

ALU54B 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis  Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 
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Table 1.6. FFT Compiler IP Core for ECP5 (LFE5UM) Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported ECP5 (LFE5UM) 

Minimal Device Needed LFE5UM-25F LFE5UM-25F LFE5UM-25F LFE5UM-25F 

Resource 
Utilization 

Targeted Device LFE5UM-85F-8BG756C 

Data Path Width 16 16 16 16 

LUTs 2335 2917 807 882 

sysMEM EBRs 3 6 3 3 

Registers 1679 2098 803 833 

MULT18X18D 12 16 4 4 

ALU54B 6 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 

 

Table 1.7. FFT Compiler IP Core for ECP5-5G (LFE5UM5G) Quick Facts 

 FFT IP Configuration 

High performance 
256 points 

High performance 
1024 points 

Low resource  

256 points 

Low resource  

1024 points 

Core 
Requirements 

FPGA Families Supported ECP5-5G (LFE5UM5G) 

Minimal Device Needed LFE5UM5G-25F LFE5UM5G-25F LFE5UM5G-25F LFE5UM5G-25F 

Resource 
Utilization 

Targeted Device LFE5UM5G-85F-8BG756C 

Data Path Width 16 16 16 16 

LUTs 1671 2917 772 879 

sysMEM EBRs 1 6 3 3 

Registers 1218 2098 775 833 

MULT18X18D 8 16 4 4 

ALU54B 4 8 2 2 

Design Tool 
Support 

Lattice Implementation Lattice Diamond 3.10.2.115 

Synthesis Synplify Pro M-2017.03L-SP1-1 

Simulation Aldec Active-HDL 10.3 Lattice Edition 

 

1.2. Features 
• Wide range of point sizes: 64, 128, 256, 512, 1024, 2048, 4096, 8192, and 16384 

• Choice of high-performance (streaming I/O) or low resource (burst I/O) versions 

• Run-time variable FFT point size 

• Forward, inverse or port-configurable forward/inverse transform modes 

• Choice of no scaling, fixed scaling (RS111/RS211) or dynamically variable stage-wise scaling 

• Data precision of 8 to 24 bits 

• Twiddle factor precision of 8 to 24 bits 

• Natural order for input and choice of bit-reversed or natural order for output 

• Support for arbitrary gaps between input data blocks in high-performance realization 

• Block floating point scaling support in low resource configurations 

http://www.latticesemi.com/legal


 FFT Compiler IP Core 
 User Guide 

© 2006-2023 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-IPUG-02045-2.2  11 

2. Functional Description 
This chapter provides a functional description of the FFT Compiler IP core. 

2.1. Block Diagram 
Figure 2.1 shows the interface diagram for the FFT compiler. The diagram shows all of the available ports for the IP. It 
should be noted that not all the I/O ports are available for a chosen configuration. 

 

Figure 2.1. FFT Compiler Interface Diagram 

FFT is a fast algorithm to implement the following N point Discrete Fourier Transform (DFT) function. 

𝑋(k) = ∑ 𝑥(n)𝑊
𝑛𝑘
𝑁

𝑁−1

𝑛=0

 

(1) 

where WN is given by: 

𝑊𝑁 = 𝑒
2𝑛
𝑁  

(2) 

The inverse DFT is given by: 

𝑋(𝑛) =
1

𝑛
∑ 𝑋 (𝑘)𝑊

−𝑛𝑘
𝑁

𝑁−1

𝑘=0

 

(3) 

However, the output of the FFT Compiler IP core differs from the true output by a scale factor determined by the 
scaling scheme. If right-shift by 1 at all stages scaling mode (RS111) is used, there is a division by 2 at every stage 
resulting in an output that is 1/Nth of the true output of Equation (1). The output for inverse FFT matches with 
Equation (3) for this scaling mode. Using other scaling modes results in outputs scaled by other appropriate scale 
factors. 

The FFT Compiler IP corer offers two different implementation modes - High Performance and Low Resource. In High 
Performance mode, the FFT Compiler IP core can continuously read in and give out one data sample per clock, block 
after block. The FFT throughput is equal to the clock rate when the data blocks are applied continuously. Low Resource 
mode uses less logic and memory resources, but requires 4 to 8 block periods to compute the FFT for one block of 
input data. Both versions of FFT do not allow breaks in the data stream within a block but do allow arbitrary additional 
gaps between data blocks. 
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2.1.1. High Performance Architecture 

The implementation diagram for the high performance FFT is shown in Figure 2.2. 

 

Figure 2.2. Implementation Diagram for High-Performance FFT 

The high performance FFT implementation consists of several processing elements (PEs) connected in cascade. The 
number of PEs is equal to log2 N, where N is the number of FFT points. Each PE has a radix-2 decimation-in-frequency 
(DIF) butterfly (bfly), a memory (mem), an address generation and control logic (control), and a scaling unit (scaling). 
Some of the butterflies include a twiddle multiplier and a twiddle factor memory. The scaling unit per- forms a division 
by 2, a division by 4, or no division, depending on the scaling mode and scale factor inputs at the port. There is an 
input-processing block at the beginning of the PE chain and an output-processing block at the end of the PE chain. The 
input processing block has registers and control logic for handshake signals and dynamic mode control. The output-
processing block contains handshake, mode control and bit-reversal logic, if configured for natural ordered output. 

The high performance FFT implementation enables streaming I/O operation, where the data is processed at clock 
speed without any gaps between blocks. This implementation can also be employed for burst I/O situations by using 
the handshake signals. 

2.1.2. Low Resource Architecture 

The low resource implementation employs only one physical radix-2 butterfly and reuses the same butterfly over 
multiple time periods to perform all stages of the FFT computation. Hence the resource requirement (EBR and slices) is 
lower compared to the high-performance version. Depending on the number of points, an N-point FFT computation 
may require 4N to 8N cycles. The implementation diagram for the low-resource FFT is shown in Figure 2.3. 

 

Figure 2.3. Low-resource FFT Data Flow Diagram 
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As Figure 2.3 shows, the FFT module is built with a butterfly reading from and writing to two memories at the same 
time. There is a commutator after the butterfly to handle the writing sequence of the intermediate outputs. The 
twiddle memory contains the pre-computed twiddle factors for the FFT. When an input block is applied, the first half of 
the block is written into memory a and the second half into memory b in a bit-reversed order. The butterfly reads from 
the two memories, performs stage 0 computation and writes out the intermediate results to the same sites in each 
memory. Again, for stage 1 computation, the butterfly reads from the two memories, performs computation and writes 
back into the two memories through the commutator. A similar process of reading, computing and writing continues 
for each of the remaining stages. For every block of input data read, four to eight blocks of computation time is 
required for this scheme. Due to the twin memory architecture, when data is unloaded form FFT in bit-reversed mode, 
the data in memory a (points 0 to N/2-1) is unloaded first, followed by the data in memory b (N/2 to N-1), both in a bit-
reversed order. 

2.2. Configuring the FFT Compiler 

2.2.1. Number of Points 

The number of points can be either fixed and specified in the interface or specified through the points input port. If the 
FFT core is going to be used for fixed points, it is better to configure it that way, to avoid the additional resource 
utilization in dynamic points configurations. In dynamic points configurations, the hardware resources used correspond 
to the maximum number of points. So to minimize resource utilization, the minimum and maximum points must be set 
to the minimum and maximum values expected in the usage. 

2.2.2. Architecture 

The operation mode must be chosen to suit the throughput requirements and resource availability. If block floating 
point scaling is required, then the Low Resource architecture must be selected. 

2.2.3. Output Order 

Output data can be chosen either to be in bit-reversed order or natural order. Natural order output is preferred in 
many applications, where the output is directly fed to the following stage. But in applications where a FIFO or a buffer 
is used between the output of FFT and the input to the next processing block, as in multi-clock systems, bit-reversal can 
be done in that glue memory. Selecting bit-reversed output results in reduced latency and/or lesser EBR usage. In low 
resource modes, the bit-reversed order is applicable separately to the lower and upper half of the output. For an N 
point FFT, the first N/2 points are available in bit-reversed order first, followed by the second N/2 points in a bit-
reversed order. 

2.2.4. Scaling Mode 

The selection of scaling mode depends on the statistical properties of the data and the trade-off between increased 
dynamic range and occasional overflows. If a large dynamic range is required for the internal computations and if the 
low-resource implementation is used, block floating point is the recommended choice. If memory and logic resource 
utilization (and possibly throughput reduction) is not a problem, full precision arithmetic (scaling selected as None) can 
be used. The data width grows by one bit every stage requiring bigger multipliers, wider data path logic and wider 
memories. The output width is equal to input width + log2N. 

Among the fixed scale factors, RS111 is a more uniform scaling method than RS211. If the input data magnitude is 
known to be higher on the average, the RS211 method may be employed. Dynamic scale mode is for more complex 
scenarios where the statistical properties of the input differ between data blocks and the user wants to use more than 
one scaling scheme. 

2.2.5. Precision Reduction Method 

Precision reduction method selection applies to the scaling process after every stage. When scaling is employed (a divide 
by 2 or 4), the scaled data is obtained either by truncating the data (discarding last one or two bits) or rounding the data 
to the nearest number in the scaled precision (discarding one or two bits and making correction to the output data 
based on discarded bits). Truncation results in less logic utilization while rounding improves the accuracy of results. 
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2.3. Signal Descriptions 
The top-level interface diagram for the FFT Compiler is shown in Figure 2.1 and the details of the I/O ports are 
summarized in Table 2.1. 

Table 2.1. Top level I/O interface 

Port Bits I/O Description 

Clock and Reset 

clk 1 I System clock. 

rstn 1 I System wide asynchronous active-low reset signal. 

Data Input and Output 

dire 8 - 24 I Data in real. Real part of the input data. 

diim 8 - 24 I Data in imaginary. Imaginary part of the input data. 

dore 8 - 24 O Data out real. Real part of the output data. 

doim 8 - 24 O Data out imaginary. Imaginary part of the output data. 

exponent Log2(N)+1 O Exponent output for block floating point. This value 
denotes the effective scaling that was done during block 
floating scaling. 

Configuration Signals 

mode 1 I FFT mode signal. Programs core to perform forward or 
inverse FFT. 

0 - Forward FFT 

1 - Inverse FFT 

The value at mode is loaded into the system whenever 
modeset input goes high. The changes are effective from 
the start of the next input data block, i.e., for an ibstart 
going high during or after modeset. 

modeset 1 I Set FFT mode signal. When this input signal goes high, the 
value at mode port is read and the FFT mode (forward or 
inverse FFT) is set. 

sfact 12 - 28 I Stage-wise scaling factors. This signal is a concatenation of 
individual 2-bit stage scaling factors. The most significant 2 
bits correspond to stage 1 scale factor, the next significant 
2 bits to stage 2 scale factor and so on. When the number 
of point is not a power of 4, the last stage has only 1-bit 
scaling factor. 

Each scaling factor denotes the number of right shifts 
performed to that stage’s output data. 

The scale factors are loaded into the system when sfactset 
input goes high. The changes are effective from the start 
of the next input data block, for example, for an ibstart 
going high during or after sfactset. 

sfactset 1 I Set scale factor signal. When this signal goes high, stage-
wise scaling factors are set with the values at sfact input 
port. 

points 3 if maximum 
points = 128 

 

4, otherwise 

I Number of FFT points. This input is used to specify the 
number of points in the dynamic points mode. The value 
at this port must be equal to the log2 of the number of 
points represented in unsigned binary form. The valid 
range of values is from 6 to 14. A value less than 6 is read 
as 6 and a value greater than 14 is read as 14. 
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Port Bits I/O Description 

pointset 1 I Set number of points signal. When this input signal goes 
high, the value at points port is read and the number of 
FFT points is set accordingly. The new number of points is 
effective from the next block of data, for example, for a 
valid ibstart applied after pointset going high. For low 
resource mode, pointset can be applied during or before 
ibstart. For high performance mode, pointset must be 
applied five cycles before ibstart. 

Status and Handshake Signals 

ibstart 1 I Input block start. Asserted high by the user to identify the 
start of an input data block. Once this signal goes high for 
a cycle, the core enters an input read cycle, during which 
input data is read in N consecutive cycles (N is the number 
of FFT points). Any ibstart signal during an input read cycle 
is ignored. 

except 1 O Exception. Denotes that an exception (overflow) has 
occurred in the computation. This could be due to the use 
of a wrong set of scaling factors. The exception always 
corresponds to a problem with the data that is currently 
output and not with a problem with the data that is being 
processed. 

rfib 1 O Ready for input block. This signal indicates that the core is 
ready to receive the next block of input data. The driving 
system can assert ibstart one cycle after rfib goes high. 
After ibstart goes high, the core pulls rfib low in the next 
clock cycle. 

ibend 1 O Input block end. This signal goes high for one cycle to 
coincide with the last sample of the current input data 
block that is being read through input ports. 

obstart 1 O Output block start. This signal is asserted high by the core 
for one clock cycle, to signify the start of an output block 
of data. 

outvalid 1 O Output data valid. This signal indicates that the core is now 
giving out valid output data through dore and doim ports. 

 

2.4. Interfacing with the FFT Compiler 

2.4.1. Configuration Signals 

There are three dynamic configuration signals used in the FFT compiler: mode, sfact and points. The user 
independently selects each of these. The configuration signals are sampled and stored when the corresponding set 
signals are active. Specifically, mode is set when modeset is active, sfact is set when sfactset is active, and points is set 
when pointset becomes active. However, these values must be set during or before the start of a block for them to be 
effective for that block. In other words, the set signals must be active at or before ibstart going active, for them to be 
effective for that block. There are a couple of exceptions to this rule. In low-resource implementation and in bit-
reversed output mode, the set signals are ignored when outvalid is high. Refer to Figure 2.6 for an illustration of 
configuration signal timing. In high performance implementation, the pointset must be applied five cycles before 
ibstart for it to be effective for the next block. 
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2.4.2. Handshake Signals 

The input ibstart is used to specify the start of a data block and it is assumed to coincide with first data point in the 
input block. This signal also sets the configuration of the core based on the values set by the corresponding set signals. 
Once ibstart is valid, the core starts reading the input in consecutive clocks without gap until all the N- points are read. 
When the last data in a block is being read from input, the output ibend is asserted high by the core. The output 
control signal rfib indicates that the core is ready for a new input block. One cycle after ibstart, the output rfib goes 
low and it remains low until one cycle before the next block can be applied. The external driving system can check for 
rfib and start an input block in the next cycle after rfib goes high. Refer to Figure 2.6 for an illustration of configuration 
signal timing. 

2.4.3. Exponent Output 

The output port exponent gives the value of the exponent of the multiplicative factor for the output to get the true FFT 
output. The value of exponent is an unsigned number. The true (i)FFT output is given by: 

True (i)FFT output = (dore * 2^exponent) + j (doim * 2^exponent) 

2.4.4. Exceptions 

Exceptions occur if there is an internal overflow in the computation of an output block. An exception is notified by the 
except signal going high during a valid output. The except signal goes high if one or more overflows occur during the 
computation of a block. The severity and number of overflow exceptions in a block depends on the scaling scheme 
used and the property of the input data. If the user is using an appropriate scaling method for the expected input data 
and can tolerate occasional exceptions, the except output may be left unconnected leading to a slightly reduced 
resource utilization. 

2.5. Timing Specifications 
The top-level timing diagrams for several cases are given in Figure 2.4 through Figure 2.7. 

 

Figure 2.4. Timing Diagram for Streaming I/O with Continuous Data Blocks (64 Points) 
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clk

ibstart

rfib

ibend

obstart

outvalid

dire,
diim

dore,
doim

 

Figure 2.5. Timing Diagram for Streaming I/O with Gaps between Data Blocks (64 Points) 

 

Figure 2.6. Timing Diagram Showing Handshake Signals for Low Resource FFT 
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clk

ibstart

rfib

ibend

dire,
diim

mode

modeset

sfact

sfactset

points

pointset

This block uses:
mode1, sfact1 and points1

This block
uses:
mode2, sfact2
and points1, as
pointset does
not arrive 5
cycles before
ibstart

 

Figure 2.7. Timing Diagram Showing Handshake Signals for High Performance FFT 

2.6. Output Latency 
Table 2.2 provides the latency through the IP core as a function of FFT point size and implementation mode. 

Table 2.2. Local User Interface Functional Groups 

FFT Point Size Low Resource Mode High Performance Mode 

64 278 83 

128 598 152 

256 1302 282 

512 2838 543 

1024 6166 1057 

2048 13334 2086 

4096 28694 4136 

8192 61462 8237 

16384 131094 16431 
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3. Parameter Settings 
The IPexpress™ tool is used to create IP and architectural modules in the Diamond and ispLEVER software. Refer to the 
IP Core Generation section for a description on how to generate the IP. 

Table 3.1 provides the list of user configurable parameters for the FFT Compiler IP core. The parameter settings are 
specified using the FFT Compiler IP core Configuration interface in IPexpress. 

Table 3.1. IP Core Parameters 

Parameters Range Default 

Number of Points 

Points variability Fixed, Variable Fixed 

Number of Points (N) 64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384 64 

Minimum points 64, 128, 256, 512, 1024, 2048, 4096, 8192 64 

Maximum points {128, 256, 512, 1024, 2048, 4096, 8192, 16384} only 
values > Min points are valid 

128 

Architecture 

Architecture High Performance, Low Resource Low Resource 

FFT Mode 

FFT Mode Forward, Inverse, Dynamic through Port Forward 

Output Order 

Output order Bit-reversed, Natural Bit-reversed 

Scaling Mode 

Scaling Mode None, RS111, RS211, Dynamic Through Port, Block 
Floating Point 

RS111 

Data Width 

Input Data Width 8 to 24 16 

Twiddle Factor Width 8 to 24 16 

Precision Reduction Method 

Precision Reduction Truncation, Rounding Truncation 

Implementation 

Multiplier Type DSP block based, LUT based DSP block based 

Adder Pipeline 0, 1 0 

Multiplier Pipeline 2, 3, 4 3 

Memory Type EBR Memory, Distributed Memory, Automatic EBR Memory 

Synthesis and Simulation Tools 

Synthesis Tools Support Synplify 

Support Precision RTL Synthesis 

Both are selected 

Simulation Tools Support ModelSim 

Support Active-HDL 

Both are selected 
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3.1. Points/Mode Tab 
Figure 3.1 shows the contents of the Points/Mode tab. 

 

Figure 3.1. Points/Mode Tab 

The Points/Mode tab provides the following options. 

3.1.1. Number of Points 

This parameter allows the user to specify fixed or variable number of points. 

3.1.1.1. Number of Points 

This parameter specifies the number of FFT points if points variability is Fixed. 

3.1.1.2. Maximum Points 

This parameter denotes the maximum for the points range if points variability is Variable. 

3.1.1.3. Minimum Points 

This parameter denotes the minimum for the points range if points variability is Variable. 

3.1.2. Architecture 

This option selects either High-Performance (Streaming I/O) or Low Resource (Burst I/O) architecture. The high-
performance implementation offers high throughput and allows streaming input and output data, with optional gaps 
between blocks. The low resource implementation results in low memory and logic resource utilization, but takes 
multiple block periods (typically between 4 to 8) of computation time to process each data block. 
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3.1.3. FFT Mode 

This parameter configures operating mode of the core to forward FFT, inverse FFT or dynamically variable for- 
ward/inverse FFT. In the Dynamic Through Port mode, the FFT mode can be set to forward or inverse FFT using the 
input ports mode and modeset. 

3.1.4. Output Order 

This parameter specifies whether the output data is in bit-reversed or natural order. 

3.2. Scaling Width Tab 
Figure 3.2 shows the contents of the Scaling Width tab. 

 

Figure 3.2. Scaling Width Tab 

The Scaling Width tab provides the following options. 

3.2.1. Scaling Mode 

This parameter defines whether the data is scaled or not after each radix-2 butterfly and if so, what kind of scaling is 
used. The value can be None, RS111, RS211, Dynamic Through Port and Block Floating Point. 

• If the value is None there is no scaling at the output of butterflies. 

• The option RS111 results in a fixed scaling of right shift by 1 in all FFT stages. 

• The option RS211 results in a fixed scaling of right shift by 2 in the first stage and right shift by 1 in the subsequent 
stages. 

• If Scale Mode is set to Dynamic Through Port, the scale factors for the FFT stages are read dynamically from the 
input port sfact for every data block. In the dynamic scaling mode, for high performance architecture, there is an 
option to set the last stage (or the last two stages, if FFT Mode is dynamic) scaling to fixed scaling to improve the 
performance. 

• In Block Floating Point scaling, the dynamic range for the intermediate computation is increased by extracting a 
common exponent for all the data points in each stage and using the full arithmetic width for processing only the 
mantissa. An additional output port exponent is added to the FFT compiler core when this option is selected. This 
option is not available for the Streaming I/O mode. 
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3.2.2. Data Width 

3.2.2.1. Input Data Width 

This parameter specifies input data width (width of either of the components: real or imaginary). 

3.2.2.2. Twiddle Factor Width 

This parameter specifies twiddle factor width (width of either of the components: real or imaginary). 

3.2.3. Precision Reduction Method 

This parameter specifies whether the data is truncated or rounded nearest during scaling. In rounding mode, for high 
performance architecture, there is an additional option to set the last stage (or the last two, if FFT Mode is dynamic) to 
truncation. Setting the last stage to truncation results in better throughput. 

3.3. Implementation Tab 
Figure 3.3 shows the contents of the Implementation tab.  

 

Figure 3.3. Implementation Tab 

The Implementation tab provides the following options. 

3.3.1. Multiplier Type 

This option specifies whether DSP blocks or LUTs are used for implementing multipliers and multiply-add components. 

3.3.2. Pipeline 

3.3.2.1. Multiplier Pipeline 

This option is used to specify the pipeline of LUT based multipliers in low resource mode. Higher values for pipeline 
leads to better performance at the cost of slightly increased utilization and latency. 

3.3.2.2. Adder Pipeline 

This option is used to specify an additional pipeline after the adders. Additional pipeline leads to better performance at 
the cost of slightly increased utilization and latency. This option is available only when architecture is low resource and 
the scale mode is not block floating point. 
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3.3.3. Memory Type 

This parameter specifies the balance between using EBR and distributed memories. If EBR memory is selected, EBRs are 
used for memory depths 32 and higher. If the Distributed Memory option is selected, EBR memories are used only for 
depths 512 or more and the rest uses distributed memories. In the automatic option, the IP generator uses a pre-
defined setting to select the EBR and distributed memories based on the FFT parameters. 

3.4. Synthesis & Simulation Tools Options Tab 
Figure 3.4 shows the contents of the Synthesis & Simulation Tools Options tab.  

 

Figure 3.4. Implementation Tab 

The Synthesis and Simulation Tools Options tab provides the following options. 

3.4.1. Support Synplify 

If selected, IPexpress generates evaluation scripts and other associated files required to synthesize the top-level design 
using the Synplify synthesis tool. 

3.4.2. Support Precision 

If selected, IPexpress generates evaluation script and other associated files required to synthesize the top-level design 
using the Precision synthesis tool. 

3.4.3. Support ModelSim 

If selected, IPexpress generates evaluation script and other associated files required to run simulation using the 
ModelSim simulator. 

3.4.4. Support ALDEC 

If selected, IPexpress generates evaluation script and other associated files required to run simulation using the ALDEC 
simulator. 
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4. IP Core Generation  
This chapter provides information on licensing the FFT Compiler IP core, generating the core using the Diamond or 
ispLEVER software IPexpress tool, running functional simulation, and including the core in a top-level design. The 
Lattice FFT Compiler IP core can be used in LatticeECP3, LatticeECP2/M, and LatticeXP2 device families. 

4.1. Licensing the IP Core 
An IP license is required to enable full, unrestricted use of the FFT Compiler IP core in a complete, top-level design. An 
IP license that specifies the IP core and device family is required to enable full use of the core in Lattice devices. 
Instructions on how to obtain licenses for Lattice IP cores are given at: 

http://www.latticesemi.com/products/intellectualproperty/aboutip/isplevercoreonlinepurchas.cfm 

Users may download and generate the IP core and fully evaluate the core through functional simulation and 
implementation (synthesis, map, place and route) without an IP license. The FFT Compiler IP core also supports Lattice’s 
IP hardware evaluation capability, which makes it possible to create versions of the IP core that operate in hardware for 
a limited time (several hours) without requiring an IP license (see the Instantiating the Core section for further details). 
However, a license is required to enable timing simulation, to open the design in the Diamond or ispLEVER EPIC tool, and 
to generate bitstreams that do not include the hardware evaluation timeout limitation. 

4.2. Getting Started 
The FFT Compiler IP core is available for download from the Lattice IP Server using the IPexpress tool. The IP files are 
automatically installed using InstallShield technology in any customer-specified directory. After the IP core is installed, 
it becomes available in the IPexpress interface dialog box shown in Figure 4.1. 

The IPexpress tool interface for the FFT Compiler IP core is shown in Figure 4.1. To generate a specific IP core 
configuration, the user specifies: 

• Project Path – Path to the directory where the generated IP files are loaded. 

• File Name – Username designation given to the generated IP core and corresponding folders and files. 

• (Diamond) Module Output – Verilog or VHDL. 

• (ispLEVER) Design Entry Type – Verilog HDL or VHDL. 

• Device Family – Device family to which IP is to be targeted (such as LatticeSCM™, Lattice ECP2M, LatticeECP3, and 
others). Only families that support the particular IP core are listed. 

• Part Name – Specific targeted part within the selected device family. 
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Figure 4.1. IPexpress Dialog Box (Diamond Version) 

Note that if the IPexpress tool is called from within an existing project, Project Path, Module Output (Design Entry in 
ispLEVER), Device Family and Part Name default to the specified project parameters. Refer to the IPexpress tool online 
help for further information. 

To create a custom configuration, the user clicks the Customize button in the IPexpress tool dialog box to display the 
FFT Compiler IP core Configuration interface, as shown in Figure 4.2. From this dialog box, the user can select the IP 
parameter options specific to their application. Refer to Parameter Settings section for more information on the 
parameter settings. 
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Figure 4.2. Configuration Dialog Box (Diamond Version) 
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4.3. IPexpress-Created Files and Top-Level Directory Structure 
When you click the Generate button in the IP Configuration dialog box, the IP core and supporting files are generated 
in the specified Project Path directory. The directory structure of the generated files is shown in Figure 4.3. 

 

Figure 4.3. Lattice FFT Compiler IP Core Directory Structure 

Table 4.1 provides a list of key files created by the IPexpress tool and how they are used. The IPexpress tool creates 
several files that are used throughout the design cycle. The names of most of the created files are customized to the 
user’s module name specified in the IPexpress tool. 

Table 4.1. File List 

File Description 

<username>_inst.v This file provides an instance template for the IP. 

<username>.v This file provides the FFT core for simulation. 

<username>_beh.v This file provides a behavioral simulation model for the FFT core. 

<username>_bb.v This file provides the synthesis black box for the user’s synthesis. 

<username>.ngo The ngo files provide the synthesized IP core. 

<username>.lpc This file contains the IPexpress tool options used to recreate or modify the core in the 
IPexpress tool. 

<username>.ipx The IPX file holds references to all of the elements of an IP or Module after it is 
generated from the IPexpress tool (Diamond version only). The file is used to bring in 
the appropriate files during the design implementation and analysis. It is also used to 
re-load parameter settings into the IP/Module generation interface when an IP/Module 
is being re-generated. 

<username>_top.[v,vhd] This file provides a module which instantiates the FFT core. This file can be easily 
modified for the user's instance of the FFT core. This file is located in the 
fft_comp_eval/<username>/src/rtl/top directory. 

twidx<username>.mem Twiddle factor to initialize ROM. The x in file name can be 0,1,2, and others. 
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File Description 

<username>_generate.tcl This file is created when the Generate button is pushed and generation is invoked. This 
file may be run from command line. 

<username>_generate.log This is the IPexpress scripts log file. 

<username>_gen.log This is the IPexpress IP generation log file. 

4.4. Instantiating the Core 
The \<fft_comp_eval> and subtending directories provide files supporting FFT IP core evaluation. The 
\<fft_comp_eval> directory shown in Figure 4.3 contains files and folders with content that is constant for all 
configurations of the FFT. The \<username> subfolder (\fft_comp_core0 in this example) contains files and folders 
with content specific to the username configuration. The \fft_comp_eval directory is created by IPexpress the first 
time the core is generated and updated each time the core is regenerated. A \<username> directory is created by 
IPexpress each time the core is generated and regenerated each time the core with the same file name is regenerated. 
A separate \<username> directory is generated for cores with different names, such as \fft_compiler_eval0, 
\fft_compiler_eval1 and others. 

4.5. Running Functional Simulation 
Simulation support for the FFT IP core is provided for Aldec Active-HDL (Verilog and VHDL) simulator and for Men- tor 
Graphics ModelSim simulator. The functional simulation includes a configuration-specific behavioral model of the FFT 
IP core. The test bench sources stimulus to the core, and monitors output from the core. The generated IP core 
package includes the configuration-specific behavior model (<username>_beh.v) for functional simulation in the 
Project Path root directory. The simulation scripts supporting ModelSim evaluation simulation is provided in 
<project_dir>\<clarity_ip_name>\<clarity_ip_instance_name>\fft_comp_eval\<clarity_ip_instance_name>\sim\mod
elsim\scripts. Moreover, the path changes when using clarity for ECP5. The simulation script supporting Aldec 
evaluation simulation is provided in \<project_dir>\fft_comp_eval\<username>\sim\aldec\scripts. Both ModelSim 
and Aldec simulation are supported via test bench files provided in \<project_dir>\fft_comp_eval\testbench. Models 
required for simulation are provided in the corresponding \models folder.  

To run the Aldec evaluation simulation: 

1. Open Active-HDL.  

2. Under the Tools tab, select Execute Macro.  

3. Browse to folder \<project_dir>\fft_comp_eval\<username>\sim\aldec\scripts and execute one of the do scripts 
shown.  

To run the ModelSim evaluation simulation: 

1. Open ModelSim.  

2. Under the File tab, select Change Directory and choose the folder 
<project_dir>\fft_comp_eval\<username>\sim\modelsim\scripts.  

3. Under the Tools tab, select Execute Macro and execute the ModelSim do script shown.  

Note: When the simulation completes, a pop-up window opens asking Are you sure you want to finish? Click No to 
analyze the results. Click Yes to close ModelSim. 

4.6. Synthesizing and Implementing the Core in a Top-Level Design 
Synthesis support for the FFT IP core is provided for Mentor Graphics Precision or Synopsys Synplify. The FFT IP core 
itself is synthesized and is provided in NGO format when the core is generated in IPexpress. Users may synthesize the 
core in their own top-level design by instantiating the core in their top-level as described previously and then 
synthesizing the entire design with either Synplify or Precision RTL Synthesis. The following text describes the 
evaluation implementation flow for Windows platforms. The flow for Linux and UNIX platforms is described in the 
Readme file included with the IP core. The top-level files <username>_top.v are provided in 
\<project_dir>\fft_comp_eval\<username>\src\rtl\top. Push-button implementation of the reference design is 
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supported via Diamond or ispLEVER project files, <user-name>.syn, located in the following directory: 
\<project_dir>\fft_comp_eval\<username>\impl\synplify (or precision). 

To use this project file in Diamond: 

1. Choose File > Open > Project. 

2. Browse to \<project_dir>\fft_comp_eval\<username>\impl\synplify (or precision) in the Open Project dialog box. 

3. Select and open <username>.ldf. All the files needed to support top-level synthesis and implementation are 
imported to the project. 

4. Select the Process tab in the left-hand interface window. 

5. Implement the complete design via the standard Diamond interface flow. 

To use this project file in ispLEVER: 

1. Choose File > Open Project. 

2. Browse to \<project_dir>\fft_comp_eval\<username>\impl\synplify (or precision) in the Open Project dialog box. 

3. Select and open <username>.syn. All the files needed to support top-level synthesis and implementation are 
imported to the project. 

4. Select the device top-level entry in the left-hand interface window. 

5. Implement the complete design via the standard ispLEVER interface flow. 

4.7. Hardware Evaluation 
The FFT Compiler IP core supports Lattice’s IP hardware evaluation capability, which makes it possible to create 
versions of the IP core that operate in hardware for a limited period of time (several hours) without requiring the 
purchase of an IP license. It may also be used to evaluate the core in hardware in user-defined designs. 

4.7.1. Enabling Hardware Evaluation in Diamond 

Choose Project > Active Strategy > Translate Design Settings. The hardware evaluation capability may be 
enabled/disabled in the Strategy dialog box. It is enabled by default. 

4.7.2. Enabling Hardware Evaluation in ispLEVER 

In the Processes for Current Source pane, right-click the Build Database process and choose Properties from the 
dropdown menu. The hardware evaluation capability may be enabled/disabled in the Properties dialog box. It is 
enabled by default. 

4.8. Updating/Regenerating the IP Core 
By regenerating an IP core with the IPexpress tool, you can modify any of its settings including device type, design entry 
method, and any of the options specific to the IP core. Regenerating can be done to modify an existing IP core or to 
create a new but similar one. 

4.8.1. Regenerating an IP Core in Diamond 

To regenerate an IP core in Diamond: 

1. In IPexpress, click the Regenerate button. 

2. In the Regenerate view of IPexpress, choose the IPX source file of the module or IP you wish to regenerate. 

3. IPexpress shows the current settings for the module or IP in the Source box. Make your new settings in the Target 
box. 

4. If you want to generate a new set of files in a new location, set the new location in the IPX Target File box. The base 
of the file name will be the base of all the new file names. The IPX Target File must end with an .ipx extension. 

5. Click Regenerate. The module’s dialog box opens showing the current option settings. 
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6. In the dialog box, choose the desired options. To get information about the options, click Help. Also, check the 
About tab in IPexpress for links to technical notes and user guides. IP may come with additional information. As the 
options change, the schematic diagram of the module changes to show the I/O and the device resources the 
module needs. 

7. To import the module into your project, if it’s not already there, select Import IPX to Diamond Project (not 
available in stand-alone mode). 

8. Click Generate. 

9. Check the Generate Log tab to check for warnings and error messages. 

10. Click Close. 

The IPexpress package file (.ipx) supported by Diamond holds references to all of the elements of the generated IP core 
required to support simulation, synthesis and implementation. The IP core may be included in a user's design by 
importing the .ipx file to the associated Diamond project. To change the option settings of a module or IP that is 
already in a design project, double-click the module’s .ipx file in the File List view. This opens IPexpress and the 
module’s dialog box showing the current option settings. Then go to step 6 above. 

4.8.2. Regenerating an IP Core in ispLEVER 

To regenerate an IP core in ispLEVER: 

1. In the IPexpress tool, choose Tools > Regenerate IP/Module. 

2. In the Select a Parameter File dialog box, choose the Lattice Parameter Configuration (.lpc) file of the IP core you 
wish to regenerate, and click Open. 

3. The Select Target Core Version, Design Entry, and Device dialog box shows the current settings for the IP core in the 
Source Value box. Make your new settings in the Target Value box. 

4. If you want to generate a new set of files in a new location, set the location in the LPC Target File box. The base of 
the .lpc file name will be the base of all the new file names. The LPC Target File must end with an .lpc extension. 

5. Click Next. The IP core’s dialog box opens showing the current option settings. 

6. In the dialog box, choose desired options. To get information about the options, click Help. Also, check the About 
tab in the IPexpress tool for links to technical notes and user guides. The IP core might come with additional 
information. As the options change, the schematic diagram of the IP core changes to show the I/O and the device 
resources the IP core needs. 

7. Click Generate. 

8. Click the Generate Log tab to check for warnings and error messages. 
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Appendix A. Resource Utilization 
This appendix provides resource utilization information for Lattice FPGAs using the FFT Compiler IP core. The IP 
configurations shown in this chapter were generated using the IPexpress software tool. IPexpress is the Lattice IP 
configuration utility, and is included as a standard feature of the Diamond and ispLEVER design tools. Details regarding 
the usage of IPexpress can be found in the IPexpress and Diamond or ispLEVER help system. For more information on 
the Diamond or ispLEVER design tools, visit the Lattice web site at: www.latticesemi.com/software. 

LatticeECP2 Devices 

Table A.1. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP™ fMAX 
(MHz) Blocks MULT18X18ADDSUB 

64 Low resource 585 741 742 3 1 2 271 

64 High performance 1059 1556 1224 1 2 4 291 

256 Low resource 608 769 770 3 1 2 263 

256 High performance 1492 2193 1686 3 3 6 274 

1024 Low resource 645 834 800 3 1 2 289 

1024 High performance 1870 2754 2106 6 4 8 262 

*Note: Performance and utilization data are generated targeting an LFE2-50-7F672C device using Lattice Diamond 3.10 and Synplify 
Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device density or 
speed grade within the LatticeECP2 family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for LatticeECP2 devices is FFT-COMP-P2-U2. 

LatticeECP2M Devices 

Table A.2. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) Blocks MULT18X18ADDSUB 

64 Low resource 624 818 777 3 1 2 281 

64 High performance 1059 1556 1224 1 2 4 289 

256 Low resource 648 852 805 3 1 2 282 

256 High performance 1492 2193 1686 3 3 6 253 

1024 Low resource 681 920 835 3 1 2 286 

1024 High performance 1870 2754 2106 6 4 8 208 

8192 Low resource 723 999 879 18 1 2 251 

8192 High performance 2442 3607 2812 23 6 12 234 

*Note: Performance and utilization data are generated targeting an LFE2M-35E-7F672C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the LatticeECP2M family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for LatticeECP2M devices is FFT-COMP-PM-U2. 
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LatticeECP3 Devices 

Table A.3. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) Blocks MULT18x18 ALU54 

64 Low resource 561 787 775 3 1 4 2 274 

64 High 
performance 

1040 1675 1218 1 2 8 4 298 

256 Low resource 585 820 803 3 1 4 2 264 

256 High 
performance 

1471 2341 1679 3 3 12 6 293 

1024 Low resource 623 893 833 3 1 4 2 272 

1024 High 
performance 

1836 2907 2098 6 4 16 8 259 

8192 Low resource 650 946 875 18 1 4 2 278 

8192 High 
performance 

2410 3783 2803 23 6 24 12 260 

*Note: Performance and utilization data are generated targeting an LFE3-95E-8FN672C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the LatticeECP3 family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for LatticeECP3 devices is FFT-COMP-E3-U2. 

LatticeXP2 Devices 

Table A.4. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) Blocks MULT18X18ADDSUB 

64 Low resource 619 810 775 3 1 2 278 

64 High performance 1054 1548 1222 1 2 4 227 

256 Low resource 643 844 803 3 1 2 252 

256 High performance 1487 2185 1684 3 3 6 228 

1024 Low resource 676 912 833 3 1 2 225 

1024 High performance 1865 2746 2104 6 4 8 213 

*Note: Performance and utilization data are generated targeting an LFXP2-17E-7F484C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the LatticeXP2 family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for LatticeXP2 devices is FFT-COMP-X2-U2. 
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ECP5 (LFE5U) Devices 

Table A.5. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) SLICEs MULT18x18 ALU54 

64 Low resource 583 773 775 3 2 4 2 235 

64 High 
performance 

1043 1671 1218 1 4 8 4 294 

256 Low resource 605 807 803 3 2 4 2 258 

256 High 
performance 

1471 2335 1679 3 6 12 6 293 

1024 Low resource 648 882 833 3 2 4 2 248 

1024 High 
performance 

1837 2917 2098 6 8 16 8 259 

*Note: Performance and utilization data are generated targeting an LFE5U-85F-8BG756C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the ECP5 (LFE5U) family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for ECP5 (LFE5U) devices is FFT-COMP-E5-U. 

ECP5 (LFE5UM) Devices 

Table A.6. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) SLICEs MULT18x18 ALU54 

64 Low resource 583 773 775 3 2 4 2 260 

64 High 
performance 

1043 1671 1218 1 4 8 4 279 

256 Low resource 605 807 803 3 2 4 2 249 

256 High 
performance 

1471 2335 1679 3 6 12 6 286 

1024 Low resource 648 882 833 3 2 4 2 244 

1024 High 
performance 

1837 2917 2098 6 8 16 8 271 

*Note: Performance and utilization data are generated targeting an LFE5UM-85F-8BG756C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the ECP5 (LFE5UM) family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for ECP5 (LFE5UM) devices is FFT-COMP-E5-U. 
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ECP5-5G (LFE5UM5G) Devices 

Table A.7. Performance and Resource Utilization* 

# Points Operating Mode SLICEs LUTs Registers 
sysMEM 

EBRs 

sysDSP fMAX 
(MHz) SLICEs MULT18x18 ALU54 

64 Low resource 582 772 775 3 2 4 2 285 

64 High 
performance 

1043 1671 1218 1 4 8 4 335 

256 Low resource 607 810 803 3 2 4 2 301 

256 High 
performance 

1471 2335 1679 3 6 12 6 289 

1024 Low resource 646 879 833 3 2 4 2 274 

1024 High 
performance 

1837 2917 2098 6 8 16 8 289 

*Note: Performance and utilization data are generated targeting an LFE5UM5G-85F-8BG756C device using Lattice Diamond 3.10 and 
Synplify Pro M-2017.03L-SP1-1. Performance may vary when using a different software version or targeting a different device 
density or speed grade within the ECP5-5G (LFE5UM5G) family. 

Ordering Part Number 

The Ordering Part Number (OPN) for the FFT Compiler for ECP5-5G (LFE5UM5G) devices is FFT-COMP-E5-U.   
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References 
For more information, refer to: 

• ECP5 / ECP5-5G FPGA website 

• LatticeECP3 FPGA website 

• LatticeECP2/M FPGA website 

• LatticeXP2 FPGA website 

• Lattice Diamond FPGA design software 

• Lattice Insights for Lattice Semiconductor training courses and learning plans 

• Lawrence R. Rabiner and Bernard Gold, “Theory and Application of Digital Signal Processing”, Prentice-Hall, Inc., 
Englewood Cliffs, NJ, 1975 
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Technical Support Assistance 
• Submit a technical support case through www.latticesemi.com/techsupport. 

• For frequently asked questions, refer to the Lattice Answer Database at 
www.latticesemi.com/en/Support/AnswerDatabase. 
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Revision History 

Document Revision 2.2, IP Version 2.9, September 2023 

Section Change Summary 

IP Core Generation Corrected the Modelsim simulation path from  

'<project_dir>\fft_comp_eval\<username>\sim\modelsim\scripts' to  

'<project_dir>\<clarity_ip_name>\<clarity_ip_instance_name>\fft_comp_eval 

\<clarity_ip_instance_name>\sim\modelsim\scripts' in the Running Functional Simulation 
section. 

References Added links to the following: 

• ECP5 / ECP5-5G FPGA website 

• LatticeECP3 FPGA website 

• LatticeECP2/M FPGA website 

• LatticeXP2 FPGA website 

• Lattice Insights 

Technical Support Added link to the Lattice Answer Database. 

Document Revision 2.1, IP Version 2.9, October 2018 

Section Change Summary 

Resource Utilization • Removed LatticeECP Devices section. Adjusted table numbers to align with the change. 

• Updated Table A.1. Performance and Resource Utilization* in LatticeECP2 Devices 
section. 

• Updated Table A.2. Performance and Resource Utilization* in LatticeECP2M Devices 
section. 

• Updated Table A.3. Performance and Resource Utilization* in LatticeECP3 Devices 
section. 

• Updated Table A.4. Performance and Resource Utilization* in LatticeXP2 Devices 
section. 

• Updated Table A.5. Performance and Resource Utilization* in ECP5 (LFE5U) Devices 
section. 

• Updated Table A.6. Performance and Resource Utilization* in ECP5 (LFE5UM) Devices 
section. 

• Updated Table A.7. Performance and Resource Utilization* in ECP5-5G (LFE5UM5G) 
Devices section. 

Document Revision 2.0, IP Version 2.5, July 2018 

Section Change Summary 

All • Changed document number from IPUG54 to FPGA-IPUG-02045. 

• Updated document template. 

Introduction • Changed the FFT IP Configuration headings from Low performance 256 points to Low 
resource 256 points and from Low performance 256 points to Low resource 1024 points 
in Table 1.1 through Table 1.4. 

• Added Table 1.5 to Table 1.7 to include ECP5 and ECP5-5G devices. 

References • Provided links to data sheets since the publication of handbooks is discontinued. 

• Added reference to ECP5 and ECP5-5G Family Data Sheet. 

Technical Support Updated contact information. 

Resource Utilization • Updated Table A.1 through Table A.5. 

• Added Table A.6 to Table A.8 to include ECP5 and ECP5-5G devices. 

• Added Ordering Part Number information for ECP5 and ECP5-5G devices. 
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Document Revision 01.9, IP Version 2.5, August 2011 

Section Change Summary 

Functional Description Added Output Latency section. 

Document Revision 01.8, IP Version 2.5, August 2010 

Section Change Summary 

All Added support for Diamond software. 

Document Revision 01.7, IP Version 2.4, June 2010 

Section Change Summary 

All Divided document into chapters. Added table of contents. 

Introduction Added Quick Facts tables. 

IP Core Generation Added new content. 

Document Revision 01.6, IP Version 2.4, May 2009 

Section Change Summary 

All Added support for LatticeECP3, updated figures and tables. 

Document Revision 01.5, IP Version 2.3, February 2008 

Section Change Summary 

Resource Utilization General update 

Document Revision 01.4, IP Version 2.2, May 2007 

Section Change Summary 

All Added support for LatticeXP2 FPGA family. 

Document Revision 01.2, IP Version 2.0, September 2006 

Section Change Summary 

All Added support for LatticeECP2 FPGA family. 

Previous Document Revisions, Previous IP Versions  

Section Change Summary 

— Previous Lattice releases. 
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